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Abstract

Kalzium is a program which shows you the Periodic Table of Elements. You can use Kalz-
ium to search for information about the elements or to learn facts about the periodic table.
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Chapter 1

Introduction

Kalzium provides you with all kinds of information about the Periodic Table of the Elements.
You can lookup lots of information about the elements and also use visualizations to show them.
It is free and licensed under the GNU Public License.

You can visualize the Periodic Table of the Elements by groups, blocks, and families. You can
plot data for a range of elements for properties like the boiling point or the atomic mass. You can
go back in time and see what elements were known at a given date. You can also calculate the
molecular mass of molecules.
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Chapter 2

Kalzium quick start guide

Here is Kalzium the first time you run it, either by selecting Applications — Education — Science
— Kalzium from the application starter or with Alt+F2 and entering kalzium into the input field.

Kalzium

File View Tools Settings Help

Classic Periodic Table ~ | Scheme  Gradients Elsompaﬁhle ,Z’g Perform Calculations P\m Data

1]

Information <

E Overview

‘ @VIEW ‘

3 s s Jee ez Jes e Jaae e iz ue dua s s oz s

scheme: | Blocks v
Gradient: | State of matter v

293,94 ~lk
-
[  Speed se—

Elements with melting point around
this temperature:

- Phesphorus (317.3K)

- Gallium (302.92K)

- Rubidium (312.63K)

- Caesium (301.54K)

- Francium (300K)

No elements with a boiling point
around this temperature

Legend

State of matter Scheme: Blocks
. Solid . Vaporous . s-Block d-Block
. Liquid Unknown - p-Block . f-Block

Xenon (54), Mass: 131.29300000000001 u

Kalzium is divided in an information panel on the left (in red), the table view (in blue) which
shows the elements of the periodic table, and a legend panel at the bottom (in green). The stan-
dard menubar allows you to choose what you want to display and the status bar reports facts.
The table view and the panels can be hidden using the corresponding items in View menu. For
example, you can hide the information panel with View — Information.

When you move the mouse cursor on an element of the table, an overview of the current element
is displayed in the Overview tab of the information panel.

You can choose several views for the table: classic periodic table, short periodic table, long peri-
odic table, etc. It is also possible to change numeration scheme or display the elements per fami-
lies, per groups, per crystal structure, depending on their acidic behavior, etc. You can change all
that in the View menu.

If you want to know facts about a precise element, click on it in the table and the information
dialog will be displayed.
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Iron (26) — Kalzium

n Data Overview
)
Atom Modsl @ WMelting Point 1808 K
IEI " Boiling Point 3023 K
Isotopes '3
= s Electron Affinity 0.151 6V
lzsalimsae 83 Electronic configuration [Ar] 3d6 452
E—— ‘\_7)' Covalent Radius 125 pm
,S ( /.," van der Waals Radius 205 pm
Extra information i
ﬁ Atomic mass 55.845u
G First lonization energy 7.902 eV
¥R Elecironegativity 1.83
Oxidation states 6,3,20,-2
H Help < Previous > Next @ Close

You can plot data using the Tools — Plot Data... menu item. You choose what you want to plot
on the y-axis and a range of elements to plot that for on the x-axis. The screenshot below shows
the atomic mass of the elements 1 to 10. Click the [&
swap X and Y axes.

Swap button between the axis panes to

Plot Data — Kalzium

X-Axis Y-Axis First element: | 1 <
Atomic Number v~ Atomic Mass ~| | Lastelement: |10 <
Minimum value: 1 ng | Minimum value: 1.00794 All elements
Maximum value: 10 Maximum value: 20.1797 Display: No Labels »

Average value: 5.5 Average value: 11.297

Element Type: | All elements v

1 Help @ Close

The Glossary (Tools — Glossary...) explains the most important chemical words and shows you
pictures of the most common tools along with an explanation.
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Search: |

> Knowledge

v~ Tools Magnetic Stir Bar

Magnetic Stir Bar Retriever

Measuring Cylinder

Magnetic stir bars are highly chemically
inert, small magnetic bars. Most heaters
have a built-in magnet which can rotate:
this causes the stir bar to rotate and the
mixture to become homogenized.

Mortar

v
=< c 4w oD

@ Close
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Chapter 3

Using Kalzium

3.1 Overview of Kalzium usage

Kalzium is very easy to use. It is specially designed for students of all ages to use as a small and
quick database.

Here is a screenshot of Kalzium in action:

Kalzium

File View Tools Settings Help

Classic Periodic Table | Scheme  Gradients [gg Isotope Table & Molecular ditor 8§ Perform Calculations  [AJ] Plot Data
Information © @ search:
I il Overview
Gold
5AU e e o e
3

8 ot == o " o+ .’ o o -
-
e | Bo | Sg ['8n |s [ac [ b | g [ n

+

Legend <)
Scheme: Blocks

. s-Block d-Block

. p-Block . f-Block

Gold (79), Mass: 196.96656899999999 u

3.2 The information dialog

The information dialog is accessed by clicking with the left mouse button on any element. This is
the place to get information about an element. With the buttons at the bottom of the dialog you
can change the element which is displayed without closing the dialog.

10
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3.2.1 Data Overview

The Data Overview page tells you about different facts related to the element.

Depending on the data available in Kalzium you will see different radii of the element. The
covalent radius is the radius of a non charged atom of the element in a molecule. The could for
example be the O-H-distance in Water. The atomic radius is the radius of an elemental atom, e.g.
not bound to anything. The van der Waals-radius is defined as the distance of two atoms of the
same sort in two equal molecules, for example two carbon-atoms in propane. The last possible
radius is the ionic radius including its charge.

The mass of an element is the average mass of all isotopes in relation to their percentage.

Iron (26) — Kalzium

X Data Overview
Data Overview
% Fe Iron Block: d
Atom Model @  Melting Point 1808 K
& - -
B Boiling Point 3023 K
Isotopes H
— w#  Electron Affinity 0.151 eV
Mz Em=ErE 88 Electronic configuration [Ar] 348 4s2
- @ Covalent Radius 125 pm
Spectrum
G @ van der Waals Radius 205 pm
Extra information
[i Atomic mass 55.845u
f":’ Eirst lonization energy 7.902 eV
®X  Electronegativity 1.83
f":’ Oxidation states 6, 3,2,0,-2
I# Help < Previous > Next @ Close

3.2.2 Bohr Orbitals

The Atom Model page displays the atomic shells. Every orbit stands for a atomic shell and every
yellow circle represents an electron.

11
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Iron (26) — Kalzium

@ Atom Model

Data Overview

[Ar] 3d° 4s*
Atom Model

Spectrum

Extra information

B Help < Previous > Next @ Close

3.2.3 Isotopes

The Isotopes page presents information about the isotopes of an element.

Mass
The mass of this isotope.

Neutrons
The number of neutrons this isotope has.

Percentage
The percentage of atoms occurring that are of this isotope type. Also called abun-
dance.

Half-life period
Only unstable isotopes have a half-life period. It is defined as the time in which half
the isotopes decay.

Energy and Mode of Decay

Some isotopes are known to emit particle radiation under the process of radioactive
decay. Each decay transformation has a typical energy release, which is listed along
with the mode of decay.

Spin and Parity
The spin of the nucleus and its parity.
Magnetic Moment

The magnetic dipole moment of the nucleus. Measured in units of the nuclear mag-
neton.

12
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Iron (26) — Kalzium

a Isotopes
T—
Data Overview
,@ Fe Iron Block: d
Atom Model Isotope-Table
. Energy Spin .
Eﬂ Mass | Neutrons | Percentage H::if:::e and Mode |and mg?nn:'ﬂc
Isotopes P of Decay Parity
% 45.0u146 19
Miscellaneous
R 5o 0.02s
Spectrum 46'2929 21 0.027 s
L 4 | 22 0.044 5
Extra information
48.SUT36 23 0.07s
49963 | 54 0.15s
50'?_'568 25 0.305s
51 G481 v
B Help < Previous > Next @ Close

3.2.4 Miscellaneous

The Miscellaneous page tells you other information about the current element, including when
it was discovered and the origin of the name.

Iron (26) — Kalzium

®

Miscellaneous

Data Overview

7

Atom Model @ This element was known to ancient cultures.

E

Isotopes

Miscellaneous

m Origin of the name:
— Latin 'ferrum’

Spectrum

8

Extra information

i# Help < Previous > Next @ Close
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3.2.5 Spectrum

The Spectrum page shows you elements spectrum. You can choose the range of the wavelengths,
units and type of the spectrum. The intensity table can be seen at the right bottom part of the
page.

(26) — Kalzium

a Spectrum

Data Overview

E‘i
Atom Model
Isotopes
—

Miscellaneous Minimum value: Maximum value: Wavelength ey
~ - ~
Hlm ZPTT v | | 438nm v | 248.327 1000
248.814 600
Reset Zoom
249.064 500
_“ > ] 252.285 400
Extra information
271.903 400
Spectrum Settings 278.81 300
Ny 344.061 400
Unit: | nanometers (nm) v

358.119 600
Type: | Emission spectrum v 371.993 600

373.4R6 700 e

I Help < Previous > Next @ Close

3.2.6 Extra Information

The Extra information page gives you the links to the element pages on Wikipedia, Jefferson Lab,
and WebElements.

14


https://education.jlab.org/
https://www.webelements.com/

The Kalzium Handbook

Iron (26) — Kalzium

@ Extra Information

Ty Wikipedia (American English)

Jefferson Lab
E’ Webelements

Spectrum
<

L

Extra information

B Hel < Previous > Next @ Close
P

3.3 Tables

The periodic table can be presented in various ways. You can switch the table view from View
menu or toolbar drop-down list.

The following options in the View — Tables menu can be used to change the table shown:

Classic Periodic Table
Display the classic periodic table with all elements.

Short Periodic Table
Display a periodic table without transition elements.
Long Periodic Table
Display a periodic table with inner transition elements (f-elements) embedded.

Transition Elements
Display a periodic table only with transition elements.

DZ Periodic Table

This item represents the table the DZ Deutscher Zentralausschuss “German Central Commit-
tee” suggests.

3.4 Numeration

The numeration is the way of numbering the 18 groups of the periodic table. You can change the
numeration to IUPAC, old IUPAC or CAS, or you can switch it off entirely.

The following options in the View — Numeration menu can be used to change the numeration
shown:

15
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No Numeration: if this option is active, no period-numeration will be in effect.

IUPAC (default) is the International Union of Pure and Applied Chemistry. This is an organization
which defines most of the standards for chemical concerns. The new IUPAC system numbers
each column with Arabic numbers from 1 (one) through 18 (eighteen).

CAS is the Chemical Abstracts Service. In the CAS system the letters A and B were designated
to main group elements (A) and transition elements (B). Though the IUPAC numeration is the
official, the CAS numeration is what is still used in classrooms and laboratories.

The Old TUPAC system labeled columns with Roman numerals followed by either the letter
‘A’ or ‘B’. Columns were numbered such that columns one through seven were numbered
‘IA” through “VIIA’, columns 8 through 10 were labeled ‘VIIIA’, columns 11 through 17 were
numbered ‘IB” through ‘VIIB” and column 18 was numbered “VIII'. Because of the confusion
the old IUPAC and the CAS system created, the [UPAC adopted their new system.

3.5 Color schemes

Kalzium can show you which elements are where with regard to their Periodic ‘block” and
‘group’, their behavior with acid and which state of matter (i.e. solid/liquid/vapor) they are
in at a given temperature.

Color schemes can be changed in the View — Scheme menu, toolbar drop-down list, or View tab
of the Sidebar.

Monochrome: all the elements have the same color. You can change the default color by
choosing Settings — Configure Kalzium... and going to the Schemes page.

Blocks: displays a color for each block.
Iconic: displays icons for each element.
Family: represents each of the nine families with a color.

Groups: displays a color for each group. A group is a vertical column in the periodic table of
the elements. There are 18 groups in the standard periodic table. Elements in a group have
similar configurations of their valence shell electrons, which gives them similar properties.

Colors: Nice colors without meaning. (From the Open Babel project).

3.6 Gradients

The gradient views displays the elements according to a property you can select below and with
a gradient colored scheme. The elements for which the data is not available are displayed in gray.

Gradients can be changed in the View — Gradients menu, toolbar drop-down list, or View tab
of the Sidebar.

16
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Kalzium

File View Tools Settings Help

| Classic Periodic Table | Scheme  Gradients Elsumpeﬁlble ‘2; violecular Editor  Zj Perform Calculations Plot Data
Information o Search:
E QOverview

Beryllium

28] view
Legend o ﬂ
Covalent Radius (linear) Scheme: Blocks
Minimum: 32 pm B sBlock d-Block
. Maximum: 225 pm . p-Block . f-Block

Beryllium (4), Mass: 9.0121819999999992 u

Implemented are the following gradients (some listed items are clickable):

* None: do not use gradients.

e State of matter
e Covalent Radius

* Van der Waals: gradient by van der Waals radius.
e Atomic Mass

¢ Boiling Point

¢ Melting Point

¢ Electronegativity (Pauling)

¢ Electronaffinity

* Discovery date

e First Ionization

3.7 Tools

3.7.1 Molecular Editor

The Molecular Editor allows you to view and edit molecules using Avogadro 2 libraries.

Using the control panel on the left, you can change the view parameters, edit molecule, or mea-
sure molecules. There are three tabs on this panel: Display, Edit, and Measure. At the top of
the window, there is a control to select the viewer Style: (can be Ball and Stick, Licorice, Van
der Waals, Van der Waals (AO) (AO means ‘Ambient Occlusion’), or Wireframe). The buttons
along the bottom of the window can be used to Load Molecule, Download New Molecules,
Save Molecule, and Close the window. The downloaded files will be saved in your Documents
folder from where you can load them into the editor.

17
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Statistics pane shows name (if available), formula, and weight of the molecule.

The Display tab can be used to view a loaded molecule. By pressing the mouse pointer in the
view, you can change the view point. Use left mouse button to rotate molecule, right mouse
button to move it, and middle mouse button to zoom.

The Edit tab allows you to edit the molecule. You can add elements by choosing them in the
Element drop-down list then clicking with the left mouse button on the view panel on the right.

The Measure tab can be used to measure distances and angles in the molecule. To make the
measurement use the instructions shown on the tab.

Molecular Editor

Display Edit Measure Style: | Ball and Stick b

Load a molecule and use the mouse pointer
and scroll wheel to change the view point.

Statistics
Name: 2-Aminoethanol
Formula: C;H;NO
Weight: 61.0831u

Save Molecule | | % Download New Molecules | | B3 Load Molecule @ Close

3.7.2 Isotope Table

The Isotope Table shows you the isotopes of the elements.

There are different kinds of isotopes, some are stable, some are not. The unstable isotopes can
decay as alpha-rays are two different beta-rays. These differences are encoded by using different
colors.

18
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Isotope Table

Information ol Jefa oo e Junfee e &
= ==
Right click on an cifsfefcafac] v e lulefo
element to view ::::::: :::::
information about it. 1 P I L L S
e e e = e
Zoom in and out using TR e = iii
your mouse wheel / v [= Lo [ | % fee o[ [ v = [ f
zoom feature. P EEEEEER T i
S el = o e o= o v ]= -
Scroll using left- e o le] e e =]
clicking and dragging pafufeeleefolxfoleln
I scroll feature. ol ERICT A I8 Ll L3 E Ea
el = e L= Lo L e
e[| o | v | [ [ | v [enoe
alpha e foe | [ | o [ [ [ | [
el = L Lo L= e
el | (o | v = [ [ | = [
el o e o L (o = | =
IEC -
e[ = v [ o [
Pfvefafuafalsr]s e fe Zoom IN/ QUT
v [ [ | w o [ (= [e
Multiple o |7 [ | e o | [ = =
o[ === = =
poOEmanne
e === =
Beta + =
e[ [l =
Lo = o]
Ll ===
Beta - = [ e
e oo [ [l
e v o] [w]w=
aonons
Stable el [ = | [
el v ]=]r
Foannn
FAoEnD
Idefau\t | S L NS A v
>

@ Close

Kalzium can display the isotopes of a range of elements

3.7.3 Plot Data

The Plot Data dialog allows you to plot some information about elements. The X-axis represents
a range of elements (from one number to a higher number). You set this range using the First

element: and Last element: fields on the dialog. Click the s Swap button between the axis
panes to swap X and Y axes.

19
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Plot Data — Kalzium

X-Axis Y-Axis First element: | 1 <
Atomic Number  ~ Atomic Mass v | | Lastelement: |10 %>
Minimum value: 1 ng | Minimum value: 1.00794 All elements
Maximum value: 10 Maximum value: 20.1797 Display: No Labels »
Average value: 5.5 Average value: 11.297

Element Type: | All elements v

Atomic Number

¥ Help @ Close

Kalzium can plot some data about a range of elements.

3.7.4 Perform Calculation

The Perform Calculation... is the Kalzium calculator. This calculator contains a variety of calcu-
lators for different tasks performing different calculations.

You can find the following calculators in Kalzium:

Molecular mass calculator
This calculator helps you calculate the molecular masses of different molecules.

You can specify short form of the molecule names add more such aliases.

20
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Chemical Calculator — Kalzium

Calculators Calculator Aliases
Introduction
Molecular mass Calc... | #Fh#oh‘ a Calc
Concentration Calcul...
Nuclear Calculator Cs Hs 0,
Gas Calculator Molecular mass: | 93.1033u
Titration Calculator
Equation Balancer
Details
Composition Aliases used
Element Atoms Atomic mass Total mass Percentage aliases

1 Carbon 6 12.0107 72.0642 77.4024 1 Ph:C6H5

2 Hydrogen 5 1.007240000... 5.0357 5.41302

3 Oxygen 1 15.9994 15.9994 17.1846

D ————————————————————————————————————— »

8 Help @ Close

Kalzium calculates molecular mass of phenol.

Concentrations calculator
You can calculate quantities which include:

¢ Amount of solute
¢ Density of solvent

* Density of solute

There are a wide range of units to choose from and different methods to specify quantities.

21
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Chemical Calculator — Kalzium

Calculators Some of the following data is not necessary. For instance, if you specify the amount of solute in moles, you do not

have to specify the molar mass of the solute.
Introduction

Molecular mass Calculator

Concentration Calculator

Nuclear Calculator Lot
Gas Calculator Calculate:
Titration Calculator e
Equation Balancer Amount of solute: | f117.0000 | grams(g) v || Mass
Molar mass of solute: | 585000 T (g/mol)
Equivalent mass of solute: | 585000 C | tg/mole)
Density of solute: | 27000 C | | grams per liter v
Amount of Solvent: | 1.0000 T liters(ly v | | volume
Molar mass of solvent: | 18.0000 2| (g/mole)
Density of Solvent: | 1000.0000 C | grams per liter v
Concentration: | 2.0000 molar v
Reset
i Help Q Close

Kalzium calculates solution parameters.

Nuclear calculator

This calculator makes use of the nuclear data available in Kalzium to predict the expected
masses of a material after time.

Chemical Calculator — Kalzium

Calculators Select what you want to calculate from the combo box next to the "calculate” label and
Introduction change the values / units to calculate.
Molecular mass Calc...
Concentration Calcul...
Nuclear Calculator Elemental data
Gas Calculator
Titration Calculator Element Name: | Uranium 7
BiustionlBalancay Isotope mass: 239.054 v
Half-life: 1407,0000 | yearn v
Atomic mass: 239.054 grams / mole
Other data
Calculate: | Time v
Initial amount: 60000 | | grams (g) ~
Final amount: | 3,0000 2| | grams (g) ~
Time: | 1407,0000 year (y) ~
Reset
B Help @ Close

Kalzium calculates parameters of uranium decay.

Gas calculator

This calculator can calculate the values of Temperature, pressure, volume, amount of gas
etc. for various ideal as well as non-ideal gases.

22
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Chemical Calculator — Kalzium

Calculators Change the quantities and observe the other quantities change dynamically.
Introduction Mass and moles are directly dependent for a given gas.
Molecular mass Calc...
Concentration Calcul...
Muclear Calculator
Gas Calculator
Titration Calculator Data
Equation Balancer
Calculate:
Molar mass of the gas: 2,0080 Z | tg/mol)

Moles: 1,0000 z

Mass: 20160 £ | grams (g) v
Pressure: 1,0000 £ | atmospheres (atm) v
Temperature: 273,0000 $ 0 kelvins (K) v
Volume: 224024 liters (1) v
Reset
i Help @ Close

Kalzium calculates gas parameters.

Titration calculator

This calculator tries to find out the equivalence point of a pH-meter followed titration best
fitting it with an hyperbolic tangent. You can also let it solve an equilibrium system of
equations and see how the concentration of a species changes in function of another one.

There are two tabs on the calculator page, namely:

Experimental values

You can use this calculator to draw the plot of your experimental data obtained during
a titration and find out the volume of equivalence. It’s strongly recommended to
insert a even number of points, because of the best fit algorithm, sorted by volume
(the X axis: value).

Theoretical Equations

Here you can fill the table with the equations you have previously obtained for the
chemical equilibrium.

For example, if you have this reaction A + B -> C + D then you will have the equation
K=(C*D)/(A*B) so you must write K in the Parameter column and (C*D) / (A*B) in
the Value column. If you want to assign a known value to a parameter you can simply
write the numeric value in the Value field.

For example, you can use the system

A= (CxD) / (B*K)

K=10"-3

C=OH
OH=(10"-14) /H
H=10"-4

B=6+ (10"-2)

Then you have to write D as X axis: and A as Y axis:: so you will find out how the
concentration of A changes as a function of D concentration.

NOTE
Please don’t use parenthesis for exponents: 10~ -3 is correct, while 10~ (=3) is wrong.
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The results can be visualized by pressing Draw Plot button. The plot shows in red the
curve that comes from theoretical equations, in blue the experimental points, and in green
the approximated curve for experimental points. You can save the plot as SVG image.

Chemical Calculator — Kalzium

Choose what you want to do: ~ ~ ~ ~

Calculators Xmin: 000 Xmax: | 5000 L, Ymin: | 0.00 Ymax: 5000
Introduction Experimental values | Theoretical equations
T T
Molecular mass Calculator Find the equivalence point from experimental values:
Concentration Calculator
Nuclear Calculator FIEED CE=EY '
Gas Calculator (1 719 20
Titration Calculator 2 764 305 40— =
Equation Balancer 3 1002 2
4 1045 315
5 wl B
6
7
Draw Plot R a
Notes:
Approximated curve: 3.26*tanh(2.66667*(x+-15.3743))+8.82
Equivalence polnt:15‘3743‘ JF
10 /
| l . P 1
10 20 0 a0
New Open Save Save plot Example
B Help @ Close

Predefined example of titration results.
Equation Balancer
The Equation Balancer enables the user to solve chemical equations. This is an example:
aH20 + bCO2 -> cH2CO3

The computed equation will be displayed on the top of the window. As you can see in the
first example you can also define the value of one or more coefficients. The other coefficients
will be adjusted. Furthermore, it is possible to use brackets around elements or electronic
charges as shown in the last two examples.

24
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Chemical Calculator — Kalzium

Calculators Equation:

Introduction aCH3(CH2)3COOH + b02 -> cH20 + dCO2
Molecular mass Calc

Concentration Calcul... Calculate

Nuclear Calculator
2 CH3(CHz)2CO0H + 13 0, -> 10 H;0 + 10 CO,
Gas Calculator

Titration Calculator Copy to Clipboard

Equation Balancer . . .
The equation solver allows you to balance a chemical equation.

Using Variables

To express variable quantities of an element, put a single character in front of the element's symbel, as shown in this examp
aH + b0 -> 5H20 (Result: 10 H + 5 0 -> 5 Hy0)

Solving this expression will give you the needed amount of Hydrogen and Oxygen.

Defining electric charges
Use box brackets to specify the electric charge of an element, as shown in this example:
4K+ + 20 -> cH20{2+] (Result: 4 H + 2 0 -> 2 H,0%)

1 H || standardsitzung: /ho | @ Lokale Ordner/Posteir Lg Konqueror || . bb : kalzium — Konso\eH . BO1-EG-AN-Ost-2¢

Kalzium calculates equation balance.

3.7.5 Risk/Security Phrases

The R/S Phrases, also known as Risk and Safety Statements, R/S statements, R/S numbers, and
R/S sentences, is a system of hazard codes and phrases for labeling dangerous chemicals and
compounds. The R/S phrase of a compound consists of a risk part (R) and a safety part (S),
each followed by a combination of numbers. Each number corresponds to a phrase. The phrase
corresponding to the letter/number combination has the same meaning in different languages.

25



3.7.6 Glossary

The Glossary gives you definitions of the most used tools in chemistry as well as some knowl-
edge data. On the left side of the windows you can see the tree of items. On top, there are

The Kalzium Handbook

ignition

R-Phrases:

S-Phrases:

B Help

R-Phrases:

1 - Explosive when dry
2 - Risk of explosion by shock, friction, fire or other sources of ignition
3 - Extreme risk of explosion by shock, friction, fire or other sources of

4 - Forms very sensitive explosive metallic compounds
5 - Heating may cause an explosion

6 - Explosive with or without contact with air

7 - May cause fire

8 - Contact with combustible material may cause fire
9 - Explosive when mixed with combustible material

S-Phrases:

1-Keep locked up

2 - Keep out of the reach of children

3-Keepin acool place

4 - Keep away from living quarters

5 - Keep contents under ... ( appropriate liquid to be specified by the
manufacturer )

6 - Keep under ... ( inert gas to be specified by the f: er)

7 - Keep container tightly closed

8 - Keep container dry

9 - Keep container in a well-ventilated place

123456789

1-2-3-4-5-6-7-8-9 Filter

@ Close

Kalzium can display Risk/Security Phrases

chemical terms, below that there is a second tree of laboratory-tools.

On the top of the widget you can see a searchbar. If you type in the bar the trees will be adjusted

immediately. The small button in the right end of the searchbar will clear it.

Search:

~ Tools

£ < cHwvwx™®»mwmg - I TmMmoONa®

>~ Knowledge

Wash Bottle

Watchglass

‘Water Jet Pump

Watchglasses are round glass panes with a diameter of around 5
- 10cm, used in various experimental techniques. The border is
bent upwards to allow the watchglass to hold small amounts of
liquids in order to let them evaporate. The evaporation can be
accelerated by heating the watchglass with a Bunsen burner.
Watchglasses can also be used to cover Petri dishes or beakers,
and are also suited to weighing small amounts of matter or
drying them in an airing cupboard. The term watchglass is
derived from the former pocket watches' protection glass which
was often domed.

@ Close
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3.7.7 Tables

The Tables shows you the tables for Greek alphabet which is used to denote some chemical
and physical entities, and for Latin prefixes and Roman numbers which correspond to common
Arabic numbers.

Kalzium <2=

“ Greek alphabet

Greek alphabet
! l Uppercase Lowercase Name

alpha '

A o
Numbers
B B beta
r Y gamma
A & delta
E E epsilon
Bl oo
3.7.8 Sidebar
3.7.8.1 Overview
Information © @
EOven:iew
Ruthenium

29 view

27



The Kalzium Handbook

The Overview tab is the first one and it shows you an overview of the element the mouse is over.

3.7.8.2 View

The View tab is the second in the navigation panel.

You are first presented with the following icons and text:

Kalzium

File View Tools Settings Help

Classic Periodic Table ~ | Scheme  Gradients Elso(opeTable ‘f(; - Ec g Perform Calculations FIo(Data
Information ¢ @ search:

il Overview

| Eﬂ\f\ew
Scheme: | Blocks — T | 3 4 & |l | B Y 10 11 1, 13 14 1 16 17 18

Gradient: | State of matter v

708,00 S|k
[  Speed ee— )

Elements with melting point around
this temperature:

- Zinc (692.73K)

- Tellurium (722.72K)

we i s M oM ma ms me oy ui

Elements with boiling point around
this temperature:

- Sulfur (717.82K) .... .... ....

Legend < 0
State of matter Scheme: Blocks

. Solid . Vaporous . s-Block d-Block

B Liquid Unknown B p-Block B f-Block

Magnesium (12), Mass: 24.305 u

Kalzium can show you which elements are solid/liquid/vaporous at a given temperature.

The View tab can be used to filter PSE. For example, this feature allows you to explore the ele-
ments of the set time period. This is great for getting a feel for how the PSE evolved over time,
as more and more elements were discovered. Choose Discovery date from Gradient: list. If you
move the slider you will notice that color of some elements disappear if you move it to the left
and reappear if you move it to the right. Furthermore the number will change constantly.

The number represents the date you are looking at. If you move the slider to e.g. 1856 you will
only see the elements which where known in the year 1856.
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File View Tools Settings Help

Information © @ search:

E QOverview

29 view
Scheme: | Blocks v L 2 )t Sk Z

Classic Periodic Table ~ | Scheme  Gradients Isu(opeTahIe .&: Molecular Editor ﬁ Perform Calculations @FlotData

1856

Gradient: | Discovery date ~ i

Legend

Discovery date (linear)
Minimum: 1669
. Maximum: 2016

Scheme: Blocks
B sBlock
. p-Block

1984

T BEEE
L H R

Mt

1982

BH BB

Ds
1994

f Es
1950 | 1952

d-Block
B -Block

Magnesium (12), Mass: 24.305u

The PSE back in time (elements known in 1856)
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Chapter 4

Configuring Kalzium

Kalzium has many configuration options, which you can access by opening the configuration
dialog by selecting Settings — Configure Kalzium... from the menu.

Configure — Kalzium

> ) Schemes
Schemes
o Blocks Groups State of Matter Family No Color Schi © >
—
>
p-Block |
Units
E d-Block: ‘
Golaator | Folock I
H Help Defa " OK + Apph Q Cancel

In the Schemes tab, you can change the different colors for each scheme.
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Configure —
® Gradients
Schemes
Instead of using a linear gradient to display the D Covalent Radius
v given property of an element in the periodic table,
Gradients Kalzium can also use a logarithmic gradient. D Van der Waals Radius
— |§| Mass
» Check the properties you want to have displayed - _
i with a logarithmic gradient. (M) Boiling Point
(W] Melting Point
E [] Electronegativity
Calculator .
[] piscovery Date
[M] Electronaffinity
(W] Tonization
Maximal Value Color: I
Minimal Value Color: ‘
i Help + OK v © Cancel

Instead of using a linear gradient to display the given property of an element in the periodic
table, Kalzium can also use a logarithmic gradient.

In the Gradients tab, you can check the properties you want to have displayed with a logarithmic
gradient.

You can also choose Maximal Value Color: and Minimal Value Color: for the gradient.

Configure —

e Units

Schemes
e Energy: electronvelts (eV) ~
Gradients Length: picometers (pm) ™

“ Temperature: kelvins (K) ~
Units

Calculator

H Help ~ OK ¢ © Cancel

In the Units tab, you can choose the units for energy, length and temperature. You can select
if you prefer electronvolts (eV), kilojoule per mole (kJ/mol), joule per mole (J/mol) or joules

(J) by default. For length set picometers (pm), nanometers (nm) or Angstrom (A) as default.
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The temperature is in kelvin by default but you can change to Celsius (C), Fahrenheit (F) and
Réaumur (Ré).

e Calculator

Schemes
e Nuclear Calculator | Gas Calculator | Mass Calculator | Concentration < >
Gradients @ Amount is always specified in term of mass
—
»
uUnits

Calculator

® Help Default ~ 0K v Apply © Cancel

Using the Calculator page, you can configure Kalzium calculators.
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Chapter 5

Command Reference

5.1 Menus and shortcut keys

5.1.1 The File Menu

File — Save As... (Ctrl+Shift+S)
Save Kalzium's table as image.

File — Export Data...
Open a dialog where you can select Elements and their Properties to export them to a
HTML, XML, or CSV file.

File — Convert chemical files...
Open a dialog to import and export a wide range of chemical file formats and data types

with the Open Babel library.
File — Quit (Ctrl1+Q)
Quits Kalzium.

5.1.2 The View Menu

View — Tables
Display a submenu with different periodic tables. The available options are:

Classic Periodic Table
Display the classic periodic table with all elements.

Short Periodic Table
Display a periodic table without transition elements.

Long Periodic Table
Display a periodic table with inner transition elements (f-elements) embedded.

Transition Elements
Display a periodic table only with transition elements.

DZ Periodic Table
This item represents the table the DZ Deutscher Zentralausschuss ‘German Central
Committee’ suggests.
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View — Numeration
Display a submenu with different numeration modes. The available options are:

No Numeration
Display no numeration scheme.

TUPAC
Display the [IUPAC numeration.

CAS
Display the CAS numeration.

Old IUPAC
Display the Old IUPAC numeration.

View — Scheme
Display a submenu with different schemes. The available options are:

Monochrome
Display all elements with one background color.

Blocks
Display the four blocks of elements.

Iconic
Display icons for each element.

Family

Display the families of elements.
Groups

Display the groups of elements.
Colors

Display the colors of elements.

View — Gradients
Display a submenu with different gradients. The available options are:

None
Disable any gradient for the table.

State of matter
Display the elements’ state of matter.

Covalent Radius
Display the elements’ covalent radius.

Van der Waals
Display the elements’ van der Waals radius.

Atomic Mass
Display the elements’ atomic mass.

Boiling Point

Display the elements’ boiling point.
Melting Point

Display the elements’ melting point.
Electronegativity (Pauling)

Display the elements’ electronegativity.
Electronaffinity

Display the elements” electron affinity.

34



The Kalzium Handbook

Discovery date

Display the discovery date of each element with different background colors for each
century.

First Ionization
Display the elements’ energy of first ionization.

View — Legend

Toggle the legend view. Allows you to display the legend for the scheme you are in
(Groups, Family, Blocks). The legend is displayed by default but if you hide it, it will stay
hidden until you choose to show it. Kalzium will keep this setting in its configuration file,
so that the next time you run it, the setting will be as you left it.

View — Information
Toggle the Sidebar.

View — Table Information
Toggle the Table Information view.

5.1.3 The Tools Menu

Tools — Molecular Editor...
Open the Molecular Editor dialog.

Tools — Isotope Table...
Open the Isotope Table window.

Tools — Plot Data...
Open the Plot Data dialog.

Tools — Perform Calculation...
Open the Perform Calculation dialog.

Tools — R/S Phrases...
Open the Risk/Security Phrases dialog.

Tools — Glossary...
Open the Glossary.

Tools — Tables...
Display a dialog with the Greek alphabet and Numeric Prefixes and Roman Numerals.

5.1.4 The Settings and Help Menu

Kalzium has the common KDE Settings and Help menu items, for more information read the
sections about the Settings Menu and Help Menu of the KDE Fundamentals.
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Chapter 6

Questions and Answers

1. Will I ever have to pay for Kalzium?

No, never. But the author always welcomes a nice mail or a DVD as a “Thank You’'. Kalzium
is licensed under the GPL, so you will never have to pay for this program.
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Chapter 7

How can I contribute?

1. Support me with data.
In the world of science, the progress is quite fast. If you ever find an incorrect or missing
value, please drop me an email.

2. Find some bugs or give some suggestions.

If you find any bugs in the program, or have a few suggestions for improvements, please
let me know at cniehaus@kde.org.
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Chapter 8
Credits and License

Kalzium
Program Copyright, 2001-2005 Carsten Niehaus cniehaus@kde.org

Contributors:

¢ Pino Toscano toscano.pino@tiscali.it

This documentation is licensed under the terms of the GNU Free Documentation License.
This program is licensed under the terms of the GNU General Public License.
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